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Trademarks
All Lattice trademarks are as listed at www.latticesemi.com/legal. Synopsys and 
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of Aldec, Inc. Modelsim and Questa are trademarks or registered trademarks of 
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countries. All other trademarks are the property of their respective owners.

Disclaimers
NO WARRANTIES: THE INFORMATION PROVIDED IN THIS DOCUMENT IS “AS IS” 
WITHOUT ANY EXPRESS OR IMPLIED WARRANTY OF ANY KIND INCLUDING 
WARRANTIES OF ACCURACY, COMPLETENESS, MERCHANTABILITY, 
NONINFRINGEMENT OF INTELLECTUAL PROPERTY, OR FITNESS FOR ANY 
PARTICULAR PURPOSE. IN NO EVENT WILL LATTICE OR ITS SUPPLIERS BE 
LIABLE FOR ANY DAMAGES WHATSOEVER (WHETHER DIRECT, INDIRECT, 
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL, INCLUDING, WITHOUT 
LIMITATION, DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION, OR 
LOSS OF INFORMATION) ARISING OUT OF THE USE OF OR INABILITY TO USE 
THE INFORMATION PROVIDED IN THIS DOCUMENT, EVEN IF LATTICE HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE SOME 
JURISDICTIONS PROHIBIT THE EXCLUSION OR LIMITATION OF CERTAIN 
LIABILITY, SOME OF THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

Lattice may make changes to these materials, specifications, or information, or to the 
products described herein, at any time without notice. Lattice makes no commitment to 
update this documentation. Lattice reserves the right to discontinue any product or 
service without notice and assumes no obligation to correct any errors contained 
herein or to advise any user of this document of any correction if such be made. Lattice 
recommends its customers obtain the latest version of the relevant information to 
establish that the information being relied upon is current and before ordering any 
products.

http://www.latticesemi.com/legal
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Type Conventions Used in This Document
Convention Meaning or Use

Bold Items in the user interface that you select or click. Text that you type 
into the user interface.

<Italic> Variables in commands, code syntax, and path names.

Ctrl+L Press the two keys at the same time.

Courier Code examples. Messages, reports, and prompts from the software.

... Omitted material in a line of code.

.

.

.

Omitted lines in code and report examples.

[ ] Optional items in syntax descriptions. In bus specifications, the 
brackets are required.

( ) Grouped items in syntax descriptions.

{ } Repeatable items in syntax descriptions.

| A choice between items in syntax descriptions.
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Chapter 1

Lattice Development Tools

Device Support and Licensing

Lattice design tools are built to help you keep innovating. Whether you are 
designing high-volume mobile handsets or leading-edge telecom 
infrastructure, our easy-to-use tools will help you bring your ideas to market 
faster - ahead of your competition.

Lattice Radiant Software
Full-featured FPGA design suite offering best-in-class tools for small form 
factor FPGA applications. Powerful yet intuitive tools provide fast design 
starts and precise implementation with intelligent planning and accurate 
analysis.

To see the supported devices, go to the Lattice Software Licensing page.

https://www.latticesemi.com/en/Support/Licensing
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Lattice Diamond Software
Leading edge design software for Lattice FPGA families. Upgrade your 
design process with an easy-to-use interface, superior design exploration, 
optimized design flow, Tcl scripting, and more.

To see the supported devices, go to the Lattice Software Licensing page.

Lattice Propel Design Environment
Lattice Propel is a complete set of graphical and command-line tools to 
create, analyze, compile, and debug both FPGA-based processor system 
hardware and software design.

To see the supported devices, go to the Lattice Software Licensing page.

ispLEVER Classic Software
ispLEVER Classic is the design environment for Lattice CPLDs and mature 
programmable products. It can be used to take a Lattice device design 
completely through the design process, from concept to device JEDEC or 
Bitstream programming file output.

Supported FPGA

 ispMACH 4000

 ispMACH 4A3

 ispMACH 4A5

 ispMach 5000VG

 ispGDX

 ispGDX2

 ispLSI 1K

https://www.latticesemi.com/en/Support/Licensing
https://www.latticesemi.com/en/Support/Licensing
https://www.latticesemi.com/en/Products/FPGAandCPLD/ispMACH4000VZ
https://www.latticesemi.com/en/Support/MatureAndDiscontinuedDevices/ispMACH4A3
https://www.latticesemi.com/en/Support/MatureAndDiscontinuedDevices/ispMACH4A5
https://www.latticesemi.com/en/Support/MatureAndDiscontinuedDevices/ispMach5000VG
https://www.latticesemi.com/en/Support/MatureAndDiscontinuedDevices/ispGDX
https://www.latticesemi.com/en/Support/MatureAndDiscontinuedDevices/ispGDX2
https://www.latticesemi.com/en/Support/MatureAndDiscontinuedDevices/ispLSI1000
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 ispLSI 2K

 ispLSI 5000VG

 ispXPGA-E

iCEcube2 Design Software
Easy-to-use design tools to help you hit your cost, power, and time-to-market 
targets. iCEcube2 design software supports the iCE40 family of ultra-low-
density FPGAs.

Supported FPGA

 iCE40 UltraPlus

 iCE40 LP/HX/LM

 iCE40 Ultra/UltraLite

https://www.latticesemi.com/en/Support/MatureAndDiscontinuedDevices/ispLSI2000
https://www.latticesemi.com/en/Products/FPGAandCPLD/iCE40UltraPlus
https://www.latticesemi.com/iCE40
https://www.latticesemi.com/Products/FPGAandCPLD/Avant-E
https://www.latticesemi.com/Products/FPGAandCPLD/Avant-E
https://www.latticesemi.com/Products/FPGAandCPLD/iCE40Ultra
https://www.latticesemi.com/support/matureanddiscontinueddevices/ispmach5000vg
https://www.latticesemi.com/en/Support/MatureAndDiscontinuedDevices/ispXPGA
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Chapter 2

Licensing Overview 

Introduction to Lattice Design Tools Licensing 
Lattice Design Tools require a license to utilize the software. This comes into 
two categories: Free and Subscription Licenses.

Free Tools licenses permit access to certain devices with the full bitstream. 
With Radiant, you can still generate bitstream with a free license using 
Evaluation Mode for certain devices.

Table 1: Device Support Per Design Flow

Device Support

Synthesize Map Place & Route Bitstream

Avant-AT-E Not Available*

Avant-AT-G Not Available*

Avant-AT-X Not Available*

Certus-N2 Evaluation Mode**

CrossLinkU-NX Evaluation Mode**

MachXO5-NX Evaluation Mode**

CertusPro-NX Evaluation Mode**

Certus-NX

CrossLink-NX

CertusPro-NX-RT Evaluation Mode**

Certus-NX-RT Evaluation Mode**

iCE40 UltraPlus

Device Support

Synthesize Map Place & Route Bitstream

ECP5UM, ECP5UM5G Not Available*

LatticeECP3 Not Available*

Radiant Free License

Diamond Free License
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How to use this Guide 
This installation guide is authored for Client Machines and License 
Administrators.

Floating License Installation
 For License Administrators who set up company servers and client 

licenses, please refer to the Server section.

 For Clients who access the server license, please refer to the Client 
section to set up the local client license.

LatticeECP2M/S, 
LatticeECP2/S

Not Available*

LatticeSC, LatticeSCM Not Available*

Crosslink, CrosslinkPlus

ECP5U

LatticeECP2, LatticeEC

MachXO3D, MachXO3L/LF

MachXO2, MachXO

LatticeXP2, LatticeXP

Platform Manager 2, 
Platform Manager

Mach-NX

Table 1: Device Support Per Design Flow (Continued)

Device Support

Synthesize Map Place & Route Bitstream

Note:
*You need a subscription license to enable full bitstream capability.

**Enables a 4-hour hardware timer. You need a subscription license to remove this and 
have full access to the bitstream.

Please visit the Lattice online store. 

Diamond Free License

https://www.latticestore.com/products/tabid/417/searchid/1/searchvalue/lsc-sw/default.aspx
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Chapter 3

Licensing Basics 

License Types 
There are two license categories for Lattice Tools: Node-locked and 
Floating.

Node-locked License 
A node-locked license is confined to use on one specific machine only. The 
license is uncounted, which means that if software is operating on a particular 
machine, there is no limit on the number of instances permitted to run.

Node-locked License: 4 Machines = 4 Licenses
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Free Node-locked License 

Subscription Node-locked License 
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Floating License 
A floating license allows multiple clients to check out individual features 
concurrently from a shared license server. Floating licenses require the 
correct license server information and daemon location. Floating licenses are 
limited to the number of features seats specified in the license.

Floating License: No of seats — No of machines with access

Free Floating License 
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Subscription Floating License 

FEATURE vs. INCREMENT in a Floating 
License

INCREMENT
Increment are additive lines in which a series of lines result in the sum of all 
the seats.

Increment lines: 1+4 = Total of 5 licenses 

FEATURE
Feature lines are not additive in which only the first feature line will be taken 
into consideration in a license file.



LICENSING BASICS : License Types

Licensing User Guide for Windows 15

Feature lines: Move the 4-seat license FEATURE line to the top of the 
license if 4 concurrent users are needed 

VERSION vs. EXPIRATION DATE in a 
License

VERSION
The Maintenance Version covers the latest valid tool version. It needs to be 
greater than the software version to run the tools.

EXPIRATION DATE
The License Expiration Date specifies the last day that the license is valid.

After March 25, 2024, this FEATURE line is no longer valid
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How to Obtain a License

Free Licenses 
Lattice offers free licenses which enable you to design and evaluate the 
performance of the supported devices per Software tool. To request free 
software licenses, see the links below. For other Software Tools, please go to 
the Software Licensing page.

Radiant Free License 
The free license enables full design and implementation functionality for 
Radiant-supported devices.

 Request Node-locked License

 Request Floating License

Diamond Free License
The free license enables you to design and evaluate the performance of non-
SERDES-based Diamond-supported devices.

 Request Node-locked License

 Request Floating License

Subscription Licenses
Subscription licenses enable you to design and optimize solutions for 
supported devices in each Software tool. To purchase or renew a Software 
license, please go to the Online Store or contact a local sales representative 
or distributor.

If you have purchased a Software license and received a Software Serial 
Number, please go to our Subscription licensing form to generate the required 
license.

Software Evaluation License

Explore our powerful Software Tools crafted to enhance your productivity and 
enjoy the seamless integration and an intuitive interface that elevates your 
design process. Experience the complete suite of any of the Lattice Software 
Tools features for 60-days. Click Request Evaluation License to get started.

https://www.latticesemi.com/en/Support/Licensing
https://www.latticesemi.com/Support/Licensing/DiamondAndiCEcube2SoftwareLicensing/Radiant
https://www.latticesemi.com/Support/Licensing/DiamondAndiCEcube2SoftwareLicensing/RadiantFreeFloating
https://www.latticesemi.com/Support/Licensing/DiamondAndiCEcube2SoftwareLicensing/DiamondFree
https://www.latticesemi.com/Support/Licensing/DiamondAndiCEcube2SoftwareLicensing/DiamondFreeFloatingLicense
https://www.latticestore.com/products/tabid/417/searchid/1/searchvalue/lsc-sw/default.aspx
https://www.latticesemi.com/Buy/SalesLocator
https://www.latticesemi.com/Buy/SalesLocator
https://www.latticesemi.com/Support/Licensing/DiamondAndiCEcube2SoftwareLicensing/DiamondSub
https://www.latticesemi.com/Support/Licensing/DiamondAndiCEcube2SoftwareLicensing/DiamondSub
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Done with the evaluation? Purchase the full subscription license in our Online 
Store or contact a local sales representative or distributor.

Subscription License 30-Day Extension
If you need a temporary license extension while license renewal is being 
processed, we have a solution for this scenario.

This license is only for a temporary extension to a subscription license that will 
expire.

To request an extension, you will need the following:

 Your subscription license serial number

 Click Request an extension and go to My Licenses to edit the record 
and click Extend 30 days.

 If you have not previously connected to our support portal, you will need to 
verify your contact information.

How to determine the MAC address/NIC 
ID 
The Network Interface Card ID uniquely identifies your workstation on the 
network. At the command prompt, you may find the NIC ID for your network 
card by running ipconfig /all. The number on the physical address line, 
without the dashes, is your NIC ID.

Physical Address Example

Note:
Use an adapter that does not change when machine is docked vs. un-docked.

https://www.latticesemi.com/Support/Licensing/DiamondAndiCEcube2SoftwareLicensing/DiamondSub
https://www.latticestore.com/products/tabid/417/searchid/1/searchvalue/lsc-sw/default.aspx
https://www.latticestore.com/products/tabid/417/searchid/1/searchvalue/lsc-sw/default.aspx
https://www.latticesemi.com/Buy/SalesLocator
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How to Fill in the Licensing Forms

Free Web Licenses
You may generate free web licenses for certain devices that are supported by 
Lattice Software Tools.

To fill in the Software Licensing Request Form

1. Ensure that you enter your NIC ID without any separator or spaces.

2. Proceed to check the tick box verifying that you are not an employee of 
Cadence Design Systems, Mentor Graphics Corporation, or Synopsys, 
Inc. 

3. You may choose to include some Free IPs listed and click generate.

Free License Software Licensing Form

Subscription Licenses
If you have purchased a Software license and received a Software Serial 
Number, you will be directed to our Subscription licensing form where you will 
need: 

 A latticesemi.com account. 

It is recommended to create an account if you do not already have one 
yet.

 The given serial number. 

https://www.latticesemi.com/Support/Licensing/DiamondAndiCEcube2SoftwareLicensing/DiamondSub
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 The NIC/Physical address of the computer you wish to license.

 Company Name

Subscription Licensing Page

Subscription Licensing Form

Evaluation Licenses 
Lattice offers evaluation license to enable free subscription license for end 
users up to 60 days. You may request an evaluation license from the 
subscription licensing self-service portal.

Note:
Click Check SN to check if the serial number is available to license.

https://www.latticesemi.com/Support/Licensing/DiamondAndiCEcube2SoftwareLicensing/DiamondSub
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Academic License Program
We offer a 1-year Lattice Design tools license free for colleges and 
universities who meet our academic license program requirements. If you are 
a professor, and you are interested in applying, please login to your Lattice 
account and fill out the application form here. If you are a student, please 
coordinate with your professor to join this program.

https://www.latticesemi.com/Support/Licensing/AcademicLicense/Academic-License-Request-Form
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Chapter 4

License Installation

To fully utilize the Lattice Software Design Tools, Software Licenses must be 
installed properly. The process depends on the type of license you are to use.

With Radiant 2024.1 and newer versions, you have the option to set the 
environment variable at the end of installation.

LM_LICENSE_FILE – generic environment variable that is a standard 
FlexLM variable used by many software tools to locate the license file or 
license server. It can be overridden by the LATTICE_LICENSE_FILE 
environment variable. This is the variable that needs to be setup and is used 
across this user guide.

LATTICE_LICENSE_FILE – environment variable used by Lattice 
Semiconductor tools (such as Radiant, Diamond, Propel) to specify the path 
to the license file required for tool activation.

SALT_LICENSE_SERVER – environment variable by Siemens Advanced 
Licensing Technology (SALT)-based applications. It defines the location of the 
license file or license server used to validate floating or node-locked licenses.

SALT_LICENSE_SERVER and LATTICE_LICENSE_FILE are used only to 
supersede or in absence of LM_LICENSE_FILE.
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Node-locked License Installation 
1. You will receive a license email once the license has been generated. 

Save the attached file (license_.dat) to the installation folder of your 
software package (e.g. <sw_install>\license\license.dat). 

2. Change the value of your Environment Variable to point to the correct 
file.

For example: LM_LICENSE_FILE = <sw_install>\license\license.dat;

To edit the LM_LICENSE FILE via “env” shortcut:

1. Click the Search bar next to the Windows symbol in the taskbar's upper 
left corner.

2. Enter env and click the Open button.

To edit the LM_LICENSE FILE via Control Panel:

1. Click the Search bar next to the Windows symbol in the taskbar's upper 
left corner.

2. Navigate to Control Panel and select System.



LICENSE INSTALLATION : Node-locked License Installation

Licensing User Guide for Windows 23

3. On the right side of the screen, click on Advanced System Settings and 
enter the computer admin username and password.

4. Click on the Environment Variables and under System variables, you 
will find the LM_LICENSE_FILE.

Note:
If you install the software tool for the first time, the LM_LICENSE_FILE will 
automatically be created with the default value <sw_install>\license\license.dat, if you 
want a different license path make sure to update the environment variable.
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Note:
If you have multiple licenses, you may add multiple license paths in the 
LM_LICENSE_FILE.
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5. You should be able to open the Lattice Design Tool without error if your 
license is properly installed.

Floating License Installation 
This section describes the floating license setup on server and client machine. 
If you are an IT admin, you may also refer to this video on setting up the 
server license. The steps below will be using LMTOOLS Graphical User 
Interface.

A separate FlexNet Licensing package is available for download separately 
from the website. Please visit the latest version on Lattice Radiant landing 
page under Downloadable Software.

Server 
You must have a license server set up on a Windows server to monitor your 
Radiant software license to allow floating licensing. Each client PC must have 
the LM_LICENSE_FILE variable set to point to the license file on the server.

To edit the License File:

http://www.latticesemi.com/Products/DesignSoftwareAndIP/FPGAandLDS/Radiant
https://youtu.be/BL78qf9GI2E?si=n5ZlE6w4cUnk1hwf
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You must change the license file after getting a floating license from Lattice 
Semiconductor to indicate the server's name and routes to the Lattice 
daemon. Please see the floating license example.

1. Edit the SERVER line by replacing nodename with the host name of the 
server for which you requested your license.dat file. You may also need to 
change the PORT NUMBER (7788). The port number should not be an 
issue. 

2. Edit the DAEMON lattice line by replacing daemon_path with the path to 
the lattice daemon, for example: 
C:\lscc\radiant\<version>\ispfpga\bin\nt64\lattice.exe

3. Edit the QuestaSim DAEMON line, replacing path_to_mgcld or 
path_to_satld with the path to:

QuestaSim Lattice Edition. For QuestaSim, the path is:

% <install_path>/radiant/<version>/questasim/license_server/
saltd.exe

saltd supports mgcld as well.

For version older than 2024.1 with only ModelSim, edit the ModelSim 
DAEMON line, replacing path_to_mgcld to <install_path>/radiant/
<version>/modeltech/win32loem/mgcld.

Floating license before editing.

Floating license after editing

To set up your license manager as a system service: 
1. Copy the license file (license.dat) to ‪C:\lscc\radiant\<version 

number>\license\license.dat.‬‬‬‬‬‬‬‬‬‬‬‬
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2. Open the LMTOOLS dialog box in this path‪ C:\lscc\radiant\<version 
number>\ispfpga\bin\nt64\lmtools.exe ‬‬‬‬‬‬‬‬‬‬‬‬

3. In the LMTOOLS dialog box, select the Config Services tab. 

4. Change the name of the service to Lattice FLEXlm Service 1. 

5. Browse and set lmgrd.exe to \ispfpga\bin\nt64\lmgrd.exe.

6. Navigate and save the license file as licenselicense.dat. You can also 
save your license in a shared folder.

7. Navigate and choose licenselattice.log as the debug log file.

8. Click and save the service.

Note:
You can save the license to any folder if it will be correctly grabbed by LMTOOLS.

Note:
If the LMTOOLS tickbox is checked on the Service/License File tab, it results to the 
tool ignoring the license path in the environment variable. When unchecked, please 
configure your LM_LICENSE_FILE environment variable. See section on how to 
configure.
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9. Choose the Start/Stop/Reread tab.

10. Click the Start Server button.

11. Navigate to the Config Services tab. 



LICENSE INSTALLATION : Floating License Installation

Licensing User Guide for Windows 29

12. To view the lattice.log file, click View Log. Check to see if the license 
server is having any issues starting up. Close the log file if there are no 
issues.

13. To validate license checkout, select Start > Open Lattice Radiant Tool 
(this will be noted in the lattice.log file).

14. In the LMTOOLS dialog box, select the Start/Stop/Reread tab. 

15. Choose the Stop Server. 

16. Navigate to the Config Services tab. Use Services and Start Server on 
Power-Up are also options.

17. Select File > Exit after clicking Save Service. 

18. Restart the Windows PC to check the server system. 

19. Restart the Radiant software to ensure that the license server is still 
operating as a service. 
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To configure your LM_LICENSE_FILE environment variable in the 
Control Panel: 
1. Modify or create your LM_LICENSE_FILE in Control Panel. 

2. Go to Advanced System Settings then Environment Variables to 
include the port@servername. The LM_LICENSE_FILE value in this case 
is: 1717@L-PF1KDFY9.

Client
The software is installed on your license server (for license manager utilities 
and daemons) as well as on each client that uses a specific software.

This setting provides the best run-time performance. Install the software 
locally on each client that will utilize the floating license after receiving your 
floating license and ensuring that the license management is operating.

To set your LM_LICENSE_FILE environment variable: 

1. Modify or create your LM_LICENSE_FILE in Control Panel.

2. Go to Advanced system settings then Environment Variables to 
include the port@servername. The LM_LICENSE_FILE value in this case 
is: 1717@L-PF1KDFY9.

License Debugger 
The license debugger is a software feature that helps you to know the 
included license features in the software license. The License File lists the 
LM_LICENSE_FILE path. The Feature list lists all the features and location 
found with Lattice Daemon. On the Local System Information, the machine 
host name and NIC IDs are shown.
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To open the License Debugger in Radiant:
1. Launch the Radiant tool. Click on the Help tab.

2. Under the Help tab, click on License Debug.

3. Click the ‘…’ button next to the Start to search for your license file. You 
can also enter your entire license path.

4. Click Start to see the included features in your license.
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5. If you need to check a specific license feature, click on the License Debug 
button and fill in the search license feature box.



IP (INTELLECTUAL PROPERTY) LICENSING : Introduction to IP Cores

Licensing User Guide for Windows 33

Chapter 5

IP (Intellectual Property) 
Licensing 

Introduction to IP Cores
Lattice IP Cores are pre-tested, reusable functions that allow designers to 
focus on their unique system architectures. These IP cores provide industry-
standard functions such as PCI Express, DDR, Ethernet, CPRI, and 
embedded microprocessors. In addition, several independent IP providers 
have teamed with Lattice to offer additional high quality, reusable IP cores. 
For a complete listing of IP cores from Lattice and its 3rd party partners, 
please go to the Lattice IP page. 

Please refer to the Product Selector Guide for the full IP Cores list and its 
device support.

Introduction to IP Licensing
Each Lattice IP core is a set of compiled code that implements a basic 
function, like a DDR2 memory controller, or a Tri-speed MAC, and is targeted/
optimized for a specific Lattice FPGA family. You can first use the IP tools in 
Diamond or Radiant to configure some parameters in the IP core (for 
example, with DDR2, you might configure the data word width to a particular 
length). 

The IP tool generates a compiled netlist, which is sometimes called a black 
box, because while you can connect the inputs and outputs, you cannot see 
inside this compiled design. Finally, using Diamond or Radiant, you can 
integrate the IP with your custom RTL to create your final design, which can 
then be programmed into a Lattice FPGA. This custom code is sometimes 
called a wrapper as it wraps around the IP core to create the final design.

After you have completed your design, you can generate a bitstream file and 
program a Lattice FPGA

If you have a copy of Diamond or Radiant, you already have access to all the 
IP core code via the IPexpress or IP Catalog tool. When you purchase an IP 
core, you now have a license to fully utilize this code - i.e. you have 
purchased a key, which comes in the form of a file called license.dat.

https://www.latticesemi.com/en/ip
https://www.latticesemi.com/view_document?document_id=9
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To get this file, you need to complete a request using the IP Subscription 
License Form. After completing the required fields in the form, we will email 
you a new license.dat file, which works with Diamond or Radiant, and unlocks 
the IP core.

Types of IP Licenses
There are 2 ways you can purchase a license to use Lattice IP cores. The 
type of IP license you purchase is reflected by the part number you order; so, 
there is only one way to license any specific IP core part number. These 
license types include:

 Single Seat Annual License: Use of the IP Core is limited to one (1) year 
from the date that Lattice issues an electronic license key to Licensee. If 
Licensee does not complete a Design within one (1) year from the date 
that Lattice issues an electronic license key to Licensee, such 
uncompleted Design may not be completed without the purchase of an 
additional license or extension for a renewal term. A node-locked Single 
Seat Annual License shall only be used on a unique machine with unique 
MAC address. A floating Single Seat Annual License shall only be used 
by one user at a time. Part numbers for a Single Seat Annual License will 
end in a suffix -US. These products are specific to a single type of IP, and 
a single target FPGA technology.

 Single Seat Perpetual License: The use of the IP Core is limited to the 
Licensee's Authorized Sites identified by Licensee in the IP Core Software 
Request Form on this website and approved by Lattice. The term of the 
Site Perpetual License is perpetual with respect the licensed IP Core and 
is a one-seat license. A node-locked Site Perpetual License shall only be 
used on a unique machine with unique MAC address. A floating Site 
Perpetual License shall only be used by one user at a time. Part numbers 
for a Multi-site Perpetual License will end in a suffix -UT. These products 
are specific to a single type of IP, and a single target FPGA technology.

For more information and support in IP licensing, please visit the Lattice IP 
Support page.

Free IP Licenses
Lattice Free IP (No License Required):

32-bit processor for Legacy Devices

 AHB-Lite Interconnect 

 AHB-Lite to APB Bridge 

 AHB-Lite to AXI4 Bridge 

 APB Interconnect 

 Avant MPPHY Module

 AXI Register Slice 

www.latticesemi.com/Support/Licensing/IPCore/IPCoreNew
www.latticesemi.com/Support/Licensing/IPCore/IPCoreNew
https://www.latticesemi.com/Support/LatticeIPSupport
https://www.latticesemi.com/Support/LatticeIPSupport
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 AXI4 Multi Port Bridge for Memory Controller 

 AXI4 to AHB-Lite Bridge 

 AXI4 to APB Bridge

 Flash Access 

 HiGig Ethernet MAC

 iCE40 UltraPlus I2S IP

 Interleaver/De-Interleaver

 Lattice Mico8 Open, Free Soft Microcontroller

 LatticeMico32 Open, Free 32-Bit Soft

 ProcessorLPDDR3 Lite Memory Controller

 Octal SPI Controller

 PHY Interface for PCI Express - PIPE

 Platform Manager Utility Function Core IP

 Programmable Interrupt Controller (PIC )

 RISC-V I/O Physical Memory Protection (IOPMP)

 RISC-V MC CPU

 RISC-V Nano CPU

 RISC-V RX CPU

 RISC-V SM CPU

 Serial Rapid IO 2.1 Endpoint 

 System Memory Module 

 Tightly-Coupled Memory (TCM)

 Timer/Counter

 UART

Lattice Free IP (Requires License): 

 2D Edge Detector

 64 Bit PCI Master/Target

 64 Bit PCI Target

 8-bit Correlator 

 Automatic White Balance

 Cascaded Integrator-Comb (CIC) Filter

 DDR SDRAM

 Debayer

 Deinterlacer

 Digital Video Broadcasting - (DVB-ASI)

 Display Interface Multiplexer
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 Distributed Arithmetic FIR Filter Generator

 Dynamic Block Reed Solomon Decoder

 Dynamic Block Reed Solomon Encoder

 eSPI Target

 GPIO 

 I2C Controller 

 I2C Target 

 Internal Flash Controller 

 Median Filter

 Numerically Controlled Oscillator

 QSPI Flash Controller 

 SPI Controller 

 SPI Flash Memory Controller

 SPI Target 

 SPI4.2

 UART 16550 

 Watchdog Timer

Evaluation Mode in IP

What are the limitations of using IP in Evaluation Mode?

You can do nearly all your design and prototyping work without an IP license. 
If you do not have a license to use the IP core, the software will insert a 
hardware timer into the programming bitstream. This will cause the bitstream 
to time-out after a set period - usually from 30 minutes to about 4 hours. After 
the period expires, you can re-program the FPGA to reset the period. Also, 
without an IP license, full timing simulation is not available.

To turn on Evaluation Mode:

1. In the Project Tab, click Active Strategy > Bitstream Settings.
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2. Check the IP Evaluation tick box.

3. Click Apply and OK to exit.
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Chapter 6

Frequently Asked Questions

1. How do I manage my subscription licenses?

 Log in to our website, https://www.latticesemi.com/ and go to Support -> 
Licensing.

 Under Purchase/Renew Radiant License, click Subscription 
licensing.

 Select My Licenses to view all licenses generated for your email address.

2. Why do I get the following warning: "WARNING - 
Device1 iM4A3-64/32 is a mature device, please 
contact Lattice for the license to enable this 
device" when loading a program for my CPLD?

Please keep in mind that when programming mature devices, you must use 
the Diamond Programmer stand-alone version. The Diamond Integrated 
Programmer (a programmer integrated into the Lattice Diamond software) 
lists the mature devices in the Device Selection and scans them, but it cannot 
program mature devices, even with the Mature Device license. Bypass is the 
only available operation.

 To program the mature device, visit our licensing page and request a 
Diamond-free license.

3. Why is my license invalid when I use a remote 
desktop?

When a Node-locked licensed is used in remote connections, the error 
described below occurs. To resolve this, you need to submit a support case to 
request for an updated license with TS_OK.

http://www.latticesemi.com/en/Support/Licensing#purchase
http://www.latticesemi.com/Support/Licensing/DiamondAndiCEcube2SoftwareLicensing/DiamondFree
https://www.latticesemi.com/Support/SubmitTechSupport
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4. How to improve Diamond/Radiant/Propel 
software startup speed caused by invalid license 
paths?

 In most cases, license paths can be edited using the LM_LICENSE_FILE 
in Windows Environment Variables (Windows Search Box >Edit 
Environment Variables). 

 However, there are instances during software startup wherein the tool 
may search for previously used paths that no longer exist (for example, 
Network License Path). To verify this, go to Help > License Debug and 
press start. There should be no licensing errors as shown below.
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 If issues occur because of invalid paths not found in the 
LM_LICENSE_FILE environment variable, you can manually modify the 
registry item. You can exit Diamond or Radiant and type REGEDIT in the 
Windows Search Box.
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 Open the Registry Editor and go to Edit > Find and search for 
LATTICE_LICENSE_FILE. This may take a few minutes.

 When the search results show the LATTICE_LICENSE_FILE registry 
entry, double-click it and delete any licensing locations that are no longer 
needed.

 To see if the program startup has improved, press OK and open Lattice 
Diamond or Lattice Radiant.
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5. How to determine the MAC Address for Debian 
OS?
 You need to upgrade first to Debian testing for dependency on a newer 

library because Debian does not name the ethernet adaptor eth0. 

To fix this using systemd:
apt install net-tools (for ifconfig -a)
create /etc/systemd/network/80-eth0.link
[Match]

MACAddress=08:62:66:4a:22:e5 (your ethernet adaptor MAC 
address)

[Link]

Name=eth0

then run update-initramfs -u
then reboot.

6. How do I use the Serial Number I received from 
Lattice License Administrator to obtain my 
Software license?
 Log in to https://www.latticesemi.com/ and navigate to http://

www.latticesemi.com/en/Support/Licensing or Support > Licensing. Click 
Diamond Subscription License. When you are in the License Generation 
page, here are the options you can do.

 Requesting a new license

 Select New License or Request a New License.

 Enter your Company Name and NIC (open an MS-DOS window and 
type "ipconfig /all" and press Enter. The MAC Address is a 12-digit 
hexadecimal value split into pairs with dashes, like this: 00-01-02-66-
1D-E0. For Linux, type ifconfig -a).

 Enter the Serial Number and click check SN. Save the file assuming 
no errors appear.

 Your license should be delivered to your mailbox within a few minutes. 

Note:
This workaround appears to have additional issues with script errors that may have 
dependencies on RHEL, as well as various requirements on 32-bit libraries before 
installing iCECube2.

https://www.latticesemi.com/
http://www.latticesemi.com/en/Support/Licensing
http://www.latticesemi.com/en/Support/Licensing
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 Renewal of expired license

 Go to My Licenses.

 Choose the expired license record you want to renew with your new 
Serial Number and press E (for edit). 

 Select Request Renewal, then enter the Company Name, First Name, 
Last Name, Email, Serial Number and proceed click.

 Select SN and save assuming no errors appear. 

 Your license should be delivered to your mailbox within a few minutes. 

 License Extension

 Go to My Licenses.

 Choose the expired license record you want to renew with your new 
Serial Number and press E (for edit). 

 Scroll down to find the Extend 30 Days button and click Extend.

 Your license should be delivered to your mailbox within a few minutes. 

7. How can I switch or transfer my license to a 
different computer or PC?
To change or transfer a license to new computer or PC, submit a technical 
support case with the new computer’s MAC address.

The license will be generated shortly after License Admin acknowledges the 
request.

https://www.latticesemi.com/Support/SubmitTechSupport
https://www.latticesemi.com/Support/SubmitTechSupport
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Revision History

The following table gives the revision history for this document.

Date Version Description

10/10/2025 1.3 Updated for 2025.1.1 release.

12/20/2024 1.2  Updated Chapter 4: Licensing Installation.

 Updated the IP license types.

06/28/2024 1.1  Added Avant-G and Avant-X devices.

 Removed ispLEVER Classic Free License table.

11/22/2023 1.0 Initial release.


	Licensing User Guide for Windows
	Contents
	Lattice Development Tools
	Device Support and Licensing
	Lattice Radiant Software
	Lattice Diamond Software
	Lattice Propel Design Environment
	ispLEVER Classic Software
	iCEcube2 Design Software


	Licensing Overview
	Introduction to Lattice Design Tools Licensing
	How to use this Guide


	Licensing Basics
	License Types
	Node-locked License
	Floating License
	FEATURE vs. INCREMENT in a Floating License
	VERSION vs. EXPIRATION DATE in a License

	How to Obtain a License
	Free Licenses
	Subscription Licenses
	How to determine the MAC address/NIC ID
	How to Fill in the Licensing Forms


	License Installation
	Node-locked License Installation
	Floating License Installation
	Server
	Client
	License Debugger


	IP (Intellectual Property) Licensing
	Introduction to IP Cores
	Introduction to IP Licensing
	Types of IP Licenses
	Free IP Licenses
	Evaluation Mode in IP


	Frequently Asked Questions
	Revision History

